
This guide is intended to help get you started quickly. 
In order to achieve optimal usage of your new iZotope 
Ozone™3, we recommend that you carefully study the 
enclosed product manual, either after completing the 
process described in this guide or before.

Quick Start Guide

64-bit Integrated Mastering System with Analog Modeling

Ozone™3
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WELCOME
Congratulations on your purchase of iZotope Ozone 3. Ozone contains some of the most powerful mastering 
DSP algorithms available today. With its intuitive meters and productivity features like preset and history 
management, Ozone provides all the tools necessary to efficiently create professional masters.

This guide will get you up and running with Ozone quickly. To learn more about Ozone’s features and tips for 
mastering, see “Getting More Help” at the end of this guide.

INSTALLATION

Mac OS X
1. Insert the iZotope Ozone 3 disc into your CD ROM drive.
2. Double-click on the iZotope Ozone 3 disc icon on your desktop to view the disc’s contents.
3. To start the setup program, double-click on the Install iZotope Ozone 3 icon.
4. Follow the steps in the setup program.

Windows
1. Insert the iZotope Ozone 3 disc into your CD-ROM drive.
2.  If the Install Ozone 3 web page does not appear automatically, double-click on the CD ROM drive’s icon 

in Windows Explorer, and double-click on the “index.html” or “index” file.
3. Click the link “Install Ozone” to start the Ozone setup.
4. If you are asked to “Open” or “Save” the file, choose “Open”.
5. Follow the steps in the setup program.

LAUNCH
Ozone is a plug-in which means it must be opened inside of an audio application often called a “host 
application”. Below are directions of one way to open Ozone in common host applications. Other applications 
have similar methods for loading a plug-in. Please consult your host application documentation for specific 
instructions.

Pro Tools LE
1. Switch to the “Edit View”.
2. Show the “Inserts View” under the “Edit View”.
3. Under “Inserts” on a track, click one of the empty plug-in slots.
4. Select “multi-channel plug-in” and “iZotope Ozone 3 (stereo)”.

Pro Tools TDM
1. Switch to the “Edit View”.
2. Show the “Inserts View” under the “Edit View”.
3. Under “Inserts” on a track, click one of the empty plug-in slots.
4. Select “TDM”, “multi-channel plug-in”, and “iZotope Ozone 3 (stereo)”.

Live
1. In the “View” menu, select “Plug-In Effects”.
2. From the list under “Plug-Ins” double-click on “iZotope Ozone 3”.
3. To view the Ozone interface, click the wrench icon in the upper-left corner.

MOTU Digital Performer
1. Open the “Mixing Board”.
2. Click and hold on an empty insert at the top of a track.
3. Select “iZotope Ozone 3”. 

Logic
1. In the “Arrange Window”, click on an audio track to select it.
2. On the left of the window, click and hold on an empty insert.
3. Select either the mono or stereo folder in the menu and then “iZotope Ozone 3”

English
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Sonar
1. On an audio track, right-click on the “FX” section.
2. Select “Audio Effects”, “iZotope”, and “Ozone 3”.

Acid

1.  Click the “Track FX” button located next to the volume and mute controls for each track. The “AUDIO 
PLUG-IN” window should now be visible with the audio chain for the selected track.

2. If the “PLUGIN-CHOOSER” is not visible, click the “Edit Chain” button.
3. Select “Ozone 3” under “Third Party” and “iZotope”, and click “OK”.

Cubase SX
1. Expand an audio track’s “Inserts” list.
2. Select one of the free slots.
3. From the pop-up menu, select “DirectX” and then “iZotope Ozone 3”.

Audition
1. Load an audio file in “Edit View”.
2. Select a portion of audio to be processed.
3. Select Ozone in the “Effects” -> “VST” -> “iZotope” -> “Ozone 3...”.

Others
Please consult your host application documentation or contact technical support.

ACTIVATION
Ozone will continue to run with full functionality for 7 days. After this period, the output will periodically be 
silenced until the plug-in is fully authorized. When you are ready to authorize, have your serial number ready 
and:

<  Launch the plug-in, and click the “Authorize” button.

Challenge/Response

< Internet Authorization
1. Click the link in “Step 1”.
2.  On the web site, enter your serial number, user name, and password, or follow the instructions to 

register and create a new account.
3. Copy the resulting Response.
4. Paste the Response into the box in “Step 2” and click “Next” to complete authorization.

< Manual Authorization
1. On the computer you want to authorize, write the challenge in “Step 1”.
2. On a computer with internet access, visit http://www.izotope.com/activate.html.
3.  Enter your serial number, user name, and password, or follow the instructions to register and create a 

new account.
4. Select the product you want to authorize by clicking “authorize with challenge/response”.
5. Enter the Challenge you wrote down and click “Submit”.
6.  Type the resulting Response into the box in “Step 2” and click “Next” to complete authorization.

iLokTM Smart Key
The iLok is only available for the Pro Tools plug-in formats.

1. Visit http://www.izotope.com/activate.html.
2.  Enter your serial number, user name, and password, or follow the instructions to register and create  

a new account.
3. Select the product you want to authorize by clicking “authorize with iLok”.
4. Enter your iLok User ID (visit www.ilok.com to create one for free).
5. Login to your account at www.ilok.com and transfer the asset to your iLok Smart Key.
6.  Insert the iLok into an open USB port on the computer that you wish to use the plug-in and you will be 

automatically authorized.
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GETTING STARTED

Presets
Presets are a great way to get to know the modules. To audition the presets, launch Ozone with audio playing 
in the host application. Click the “PRESETS” button and click through each preset to hear the difference in 
sound. Click “OK” to select the preset and work with the parameters.

GETTING MORE HELP

Help
Click the ‘?’ button located in the lower right of each window to bring up context-sensitive help. These help 
documents describe all of the features, some simple tips, and keyboard shortcuts. 

Mastering and Dithering Guides
For the beginner, the Ozone Mastering Guide provides an excellent overview of the process of mastering. For 
the seasoned pro, the guide also provides tips and tricks that will help you get the most out of Ozone.

The Dithering Guide is the must-read resource for understanding and using dither. It highlights the common 
pitfalls and is crucial to achieving the highest possible quality in your final product.

The Mastering and Dithering Guides are included on the Ozone 3 disk.

Support
For additional help, technical support is available on our website at www.m-audio.com, where you can fill 
out our technical support form.

Alternatively, you can email us at support@m-audio.com, or contact us by phone at: 

(626) 633-9055.

Technical support is available by telephone from 7am - 7pm PST.
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BIENVENUE
Félicitations pour votre achat d’Ozone 3 d’iZotope. Ozone contient certains des algorithmes DSP de mastering 
les plus puissants qui soient. Avec ses indicateurs intuitifs et des fonctionnalités de productivité comme la 
gestion de presets et d’historique, Ozone fournit tous les outils nécessaires pour créer efficacement des 
masters professionnels.

Ce guide vous permettra de démarrer rapidement avec Ozone. Pour en savoir plus sur les fonctionnalités 
d’Ozone, et pour des conseils liés au mastering, reportez-vous à la section “Pour obtenir une assistance 
supplémentaire” à la fin de ce guide.

INSTALLATION

Mac OS X
1. Insérez le CD iZotope Ozone 3 dans le lecteur CD-ROM.
2.  Double-cliquez sur l’icône de disque iZotope Ozone 3 lorsqu’elle apparaît sur votre bureau afin de 

visualiser le contenu du CD. 
3. Pour lancer le programme d’installation, double-cliquez sur l’icône Install iZotope Ozone 3.
4. Suivez les  étapes dans le programme d’installation.

Windows
1. Insérez le CD iZotope Ozone 3 dans le lecteur CD-ROM.
2.  Si la page web Install Ozone 3 n’apparaît pas automatiquement, double-cliquez sur l’icône du CD-ROM 

dans Windows Explorer, et double-cliquez sur le fichier “index.html” ou  “index”.
3. Cliquez sur le lien “Install Ozone” pour démarrer l’installation Ozone.
4. Si on vous demande d’ouvrir ou d’enregistrer (Open ou Save) le fichier, choisissez de l’ouvrir (Open).
5. Suivez les étapes dans le programme d’installation.

DEMARRAGE
Ozone est un plug-in, ce qui signifie qu’il doit être ouvert depuis une application audio souvent appelée 
“application hôte”. Voici des instructions sur une façon d’ouvrir Ozone dans des applications hôte ordinaires. 
D’autres applications ont des méthodes similaires pour charger un plug-in. Veuillez consulter la documentation 
de votre application hôte pour des instructions spécifiques.

Pro Tools LE
1. Passez dans en mode d’affichage “Edit View” (affichage d’édition).
2. Affichez les “Inserts View” (visualisation des inserts) sous “Edit View”.
3. Sous “Inserts” dans une piste, cliquez un des logements de plug-in.
4. Sélectionnez “multi-channel plug-in” et “iZotope Ozone 3 (stereo)”.

Pro Tools TDM
1. Passez dans en mode d’affichage “Edit View” (affichage d’édition).
2. Affichez les “Inserts View” (visualisation des inserts) sous “Edit View”.
3. Sous “Inserts” dans une piste, cliquez un des logements de plug-in.
4. Sélectionnez “TDM”, “multi-channel plug-in” et “iZotope Ozone 3 (stereo)”.

Live
1. Dans le menu “View” sélectionnez “Plug-In Effects”.
2. Dans la liste sous “Plug-Ins”, double-cliquez sur “iZotope Ozone 3”.
3. Pour afficher l’interface Ozone, cliquez sur la clé dans le coin supérieur gauche.

MOTU Digital Performer
1. Ouvrez le “Mixing Board”.
2. Cliquez et maintenez enfoncé sur un insert vide au sommet d’une piste.
3. Sélectionnez “iZotope Ozone 3”. 

Français
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Logic
1. Dans la fenêtre “Arrange Window”, cliquez sur une piste audio pour la sélectionner.
2. Sur la gauche d’une fenêtre, cliquez et maintenez enfoncé sur un insert vide.
3. Sélectionnez soit le dossier mono soit le dossier stéréo dans le menu, puis “iZotope Ozone 3”.

Sonar
1. Sur une piste audio, cliquez à droite sur la section “FX”.
2. Sélectionnez “Audio Effects”, “iZotope”, et “Ozone 3”.

Acid
1.  Cliquez le bouton “Track FX” placé à côté des contrôles de volume et de sourdine pour chaque 

piste. La fenêtre “AUDIO PLUG-IN” devrait maintenant être visible dans la chaîne audio pour la piste 
sélectionnée.

2. Si le “PLUGIN-CHOOSER” n’est pas visible, cliquez sur le bouton “Edit Chain”.
3. Sélectionnez “Ozone 3” sous “Third Party” et “iZotope”, puis cliquez sur “OK”.

Cubase SX
1. Développez une liste “Inserts” d’une piste audio.
2. Sélectionnez un des logements disponibles.
3. Dans le menu déroulant, sélectionnez “DirectX” puis “iZotope Ozone 3”.

Audition
1. Chargez un fichier audio dans “Edit View”.
2. Sélectionnez une portion de l’audio à traiter.
3. Sélectionnez Ozone dans “Effects” -> “VST” -> “iZotope” -> “Ozone 3...”.

Autres
Veuillez consulter la documentation de votre application hôte ou contacter l’assistance technique.

ACTIVATION
Ozone continuera à être pleinement fonctionnel pour une durée de 7 jours. Après cette période, la sortie sera 
périodiquement mise en sourdine, jusqu’à ce que le plug-in soit pleinement autorisé. Quand vous êtes prêt 
à procéder à l’autorisation, ayez votre numéro de série à proximité, et :

< Démarrez le plug-in, et cliquez sur le bouton “Authorize”.

Défi/Réponse
< Autorisation Internet
1. Cliquez sur le lien dans l’étape 1.
2.  Sur le site web, entrez votre numéro de série, votre nom d’utilisateur et votre mot de passe, ou suivez 

les instructions pour vous enregistrer et créer un nouveau compte.
3. Copiez la réponse qui en résulte.
4. Collez la réponse dans la case de l’étape 2 et cliquez sur Next pour terminer l’autorisation.

< Autorisation manuelle
1. Sur l’ordinateur que vous voulez autoriser, écrivez le défi (challenge) dans l’étape 1.
2. Sur un ordinateur avec accès Internet, visitez http://www.izotope.com/activate.html.
3.  Entrez votre numéro de série, votre nom d’utilisateur et votre mot de passe, ou suivez les instructions 

pour vous enregistrer et créer un nouveau compte.
4.  Sélectionnez le produit que vous souhaitez autoriser en cliquant sur “authorize with challenge/

response”.
5. Entrez le défi que vous avez écrit et cliquez sur “Submit”.
6.   Collez la réponse dans la case de l’étape 2 et cliquez sur Next pour terminer l’autorisation.
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iLokTM Smart Key
Le iLok n’est utilisable que pour les formats de plug-in Pro Tools.

1. Veuillez consulter http://www.izotope.com/activate.html .
2.  Entrez votre numéro de série, votre nom d’utilisateur et votre mot de passe, ou suivez les instructions 

pour vous enregistrer et créer un nouveau compte.
3. Sélectionnez le produit que vous souhaitez autoriser en cliquant sur “authorize with iLok”.
4. Entrez votre User ID iLok  (consultez www.ilok.com pour en créer un gratuitement).
5.  Ouvrez une session sur votre compte dans www.ilok.com et transférez l’asset dans votre Smart Key 

iLok.
6.  Insérez l’iLok dans un port USB de l’ordinateur sur lequel vous souhaitez utiliser le plug-in et vous serez 

automatiquement autorisé.

INSTRUCTIONS DE DEPART

Presets
Les presets sont une excellente manière d’apprendre à connaître les modules. Pour écouter les presets, 
lancez Ozone tandis que de l’audio est lu dans l’application hôte. Cliquez sur le bouton “PRESETS” et cliquez 
sur chaque preset pour entendre la différence dans le son. Cliquez sur “OK” pour sélectionner le preset et 
travailler avec les paramètres.

OBTENIR DE L’ASSISTANCE SUPPLEMENTAIRE

Assistance
Cliquez sur le bouton ‘?’ placé dans le coin inférieur droit de chaque fenêtre pour faire apparaître une aide 
contextuelle. Ces documents d’aide décrivez toutes les fonctionnalités, quelques conseils simples, et des 
raccourcis clavier. 

Guides de mastering et de dithering
Pour le débutant, l’Ozone Mastering Guide (Guide du mastering Ozone) fournit un excellent survol du 
processus de mastérisation. Pour le professionnel expérimenté, le guide fournit également des conseils qui 
vous aideront à tirer le meilleur d’Ozone.

Le Dithering Guide est une ressource indispensable pour comprendre et utiliser le dithering. Il met en évidence 
les pièges courants et est crucial pour atteindre la plus haute qualité possible dans votre produit final.

Les guides sur le Mastering et le Dithering sont inclus sur le disque Ozone 3. 

Assistance
Merci de consulter en premier lieu notre base de connaissance sur le site www.m-audio.fr Vous pourrez aussi 
y remplir un formulaire d’assistance qui sera transmis à nos services techniques qui vous répondront le plus 
rapidement possible.

Vous pouvez aussi joindre nos services ci-dessous :
< Assistance Technique PC : 
 Tél. : 0820 000 731 (0,12€ ttc/min) – email : support@m-audio.fr
< Assistance Technique Mac : 
 Tél. : 0820 391 191 (0,12€ ttc/min) – email : mac@m-audio.fr 

Site Internet: http://www.m-audio.fr

041104_IzotopeOzone3_QS.indd   9 11/9/04   3:35:11 PM



11

WILLKOMMEN!
Vielen Dank, dass Sie sich für iZotope Ozone 3 von M-Audio entschieden haben! Ozone zeichnet sich 
durch neueste, äußerst leistungsstarke DSP-Mastering-Algorithmen aus. Mit seinen intuitiven Anzeigen 
und Produktivitätsfunktionen wie Preset- und History-Management verfügt Ozone über alle notwendigen 
Werkzeuge, um effektiv professionelle Masters zu erstellen.

Die vorliegende Quick-Start-Anleitung gibt Ihnen einen Überblick über die Funktionen von Ozone und 
ermöglicht Ihnen eine schnelle Inbetriebnahme des Plug-Ins. Weitere Informationen über die Funktionen von 
Ozone und Tipps für das Erstellen von Masters finden Sie im Abschnitt “Weitere Informationen” im Anhang 
dieser Anleitung.

INSTALLATION

Mac OS X
1. Legen Sie die iZotope Ozone 3-CD in das CD-Laufwerk Ihres Computers ein.
2.   Doppelklicken Sie das iZotope Ozone 3-CD-Symbol auf dem Desktop, um den Inhalt der CD 

anzuzeigen.
3. Starten Sie das Setup-Programm, indem Sie das iZotope Ozone 3-Symbol doppelklicken.
4. Folgen Sie der Bildschirmführung.

Windows
1.   Legen Sie die iZotope Ozone 3-CD in das CD-Laufwerk Ihres Computers ein.
2.  Sollte die Install Ozone 3-Webseite nicht automatisch geladen werden, doppelklicken Sie zunächst das 

CD-ROM-Symbol im Windows Explorer und anschließend die “index.html” oder “index”-Datei.
3. Klicken Sie auf den Link “Install Ozone”, um das Setup zu starten.
4. Falls Sie aufgefordert werden, die Datei zu “öffnen” oder “speichern” , wählen Sie “öffnen”.
5. Folgen Sie der Bildschirmführung.

START
Ozone ist ein Plug-In, das im Rahmen einer Audio-Anwendung (Host-Anwendung) geöffnet werden muss. 
Es folgt eine Beschreibung, wie Sie Ozone in den bekanntesten Host-Anwendungen öffnen. Bei anderen 
Anwendungen gehen Sie ähnlich vor, um ein Plug-in zu laden. Lesen Sie hierzu bitte auch die Dokumentation 
Ihrer Audio-Software.

Pro Tools LE
1. Wechseln Sie zu “Edit View”.
2. Wählen Sie in “Edit View” die Option “Inserts View”.
3. Klicken Sie unter “Inserts” bei einem Track auf einen leeren Plug-In-Slot.
4. Wählen Sie “multi-channel plug-in” und “iZotope Ozone 3 (stereo)”.

Pro Tools TDM
1. Wechseln Sie zu “Edit View”.
2. Wählen Sie in “Edit View” die Option “Inserts View”.
3. Klicken Sie unter “Inserts” bei einem Track auf einen leeren Plug-In-Slot.
4. Wählen Sie “TDM”, “multi-channel plug-in”, und “iZotope Ozone 3 (stereo)”.

Live
1. Wählen Sie im “View”-Menü “Plug-In Effects”.
2. Doppelklicken Sie in der Liste unter “Plug-Ins” auf “iZotope Ozone 3”.
3.  Klicken Sie auf das Schraubenschlüsselsymbol in der linken oberen Ecke, um die Ozone-

Benutzeroberfläche zu öffnen.

MOTU Digital Performer
1. Öffnen Sie das “Mixing Board”.
2. Klicken Sie auf einen freien Einfügeplatz über einem Track.
3. Wählen Sie “iZotope Ozone 3”. 

Deutsch
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Logic
1. Klicken Sie im “Arrange”-Fenster auf einen Audiotrack um ihn auszuwählen.
2. Klicken Sie links im Fenster auf einen freien Einfügeplatz.
3. Wählen Sie entweder das Mono- oder das Stereoverzeichnis aus und anschließend “iZotope Ozone 3” 

Sonar
1. Klicken Sie in einem Audiotrack mit der rechten Maustaste auf “FX”.
2. Wählen Sie “Audio Effects”, “iZotope” und “Ozone 3”aus.

Acid
1.  Klicken Sie auf die “Track FX”-Schaltfläche neben den Lautstärke- und Mute-Reglern der einzelnen 

Tracks. Neben der Audiodarstellung sollte nun das “AUDIO PLUG-IN”-Fenster für den ausgewählten 
Track erscheinen.

2. Falls die “PLUGIN-AUSWAHL” nicht erscheint, klicken Sie auf die “Edit Chain”-Schaltfläche.
3. Wählen Sie unter “Third Party” und “iZotope” nun “Ozone 3” aus und klicken Sie auf “OK”.

Cubase SX
1. Erweitern Sie die “Insert”-Liste eines Audiotracks.
2. Wählen Sie einen der freien Slots.
3. Wählen Sie anschlißend aus dem Pop Up-Menü  “DirectX” und “iZotope Ozone 3”.

Audition
1. Laden Sie im “Edit-View” eine Audiodatei.
2. Wählen Sie einen Abschnitt für die Bearbeitung aus.
3. Wählen Sie in “Effects” -> “VST” -> “iZotope” -> “Ozone 3...” Ozone aus.

Andere
Nutzer anderer Anwendungen lesen bitte das entsprechende Benutzerhandbuch oder wenden sich an den 
technischen Support.

AKTIVIERUNG
Ozone kann für weitere sieben Tage mit sämtlichen Funktionen getestet werden. Danach wird der 
Audioausgang in unregelmäßigen Abständen stummgeschaltet bis der Plug-In zugelassen wurde. Zur 
Registrierung benötigen Sie die Seriennummer des Programms.

< Starten Sie den Plug-In und klicken Sie auf “Authorize”.

Challenge/Response
< Online-Zulassung
1. Klicken Sie auf den Link in “Schritt 1”.
2.  Auf der sich nun öffnenden Webseite geben Sie bitte die Seriennummer, Benutzername und Passwort 

ein oder folgen Sie den Anweisungen, um ein neues Benutzerkonto zu erstellen.
3. Kopieren Sie den erscheinenden Response-Code
4. und fügen Sie ihn in das Feld in “Schritt 2” ein. Klicken Sie auf “Next” um die Zulassung  fertigzustellen.

< Manuelle Zulassung
1. Schreiben Sie auf dem Computer, den Sie zulassen wollen den Challenge-Code aus “Schritt 1”.
2.  Gehen Sie mit einem (anderen) Computer online und öffnen Sie die Seite http://www.izotope.com/

activate.html.
3.  Geben Sie hier bitte die Seriennummer, Benutzername und Passwort ein oder folgen Sie den 

Anweisungen, um ein neues Benutzerkonto zu erstellen.
4.  Wählen Sie das Produkt, das Sie zulassen wollen indem Sie auf “authorize with challenge/response” 

klicken.
5. Geben Sie den notierten Challenge-Code ein und klicken Sie auf “Submit”.
6.  Geben Sie den nun erscheinenden Response-Code in das Feld in “Schritt 2” ein. Klicken Sie auf “Next”, 

um die Zulassung fertigzustellen.
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iLokTM Smart Key
iLok ist nur für Pro Tools Plug-In-Formate erhältlich.

1. Besuchen Sie bitte die Website: http://www.izotope.com/activate.html
2.  Geben Sie hier bitte die Seriennummer, Benutzername und Passwort ein oder folgen Sie den 

Anweisungen, um ein neues Benutzerkonto zu erstellen.
3. Wählen Sie das Produkt, das Sie zulassen wollen indem Sie auf “authorize with iLok” klicken.
4.  Geben Sie Ihre  iLok-Benutzer-ID ein. (Auf www.ilok.com können Sie kostenlos ein Benutzer-ID 

erstellen).
5.  Loggen Sie sich in Ihr  iLok-Account ein und übertragen Sie das Guthaben auf Ihr iLok Smart Key 
 www.ilok.com
6. Schließen Sie Ihr iLok an einen freien USB-Port an. Der Plug-In wird automatisch zugelassen.

ERSTE SCHRITTE

Presets
Über Presets ist es ein Leichtes, die einzelnen Module besser kennenzulernen. Um die Presets anzuhören, 
starten Sie Ozone während über die Host-Anwendung Audio abgespielt wird. Klicken Sie auf die “PRESETS”-
Schaltfläche und wählen Sie probeweise die verschiedenen Presets aus. Klicken Sie auf “OK” um einen Preset 
auszuwählen und die Parameter zu bearbeiten.

WEITERE INFORMATIONEN

Hilfe
Klicken Sie auf die Schaltfläche mit dem Fragezeichen (unten rechts in den Fenstern), um die kontextbezogene 
Hilfe aufzurufen. So können Sie sich die Beschreibung aller Funktionen, eine Reihe nützlicher Tipps und die 
Liste der Tastaturbefehle anzeigen lassen. 

Anleitungen zum Mastering und Dithering
Die Ozone Mastering Guide bietet Anfängern eine hervorragende Übersicht über das Mastering und sein 
Ablauf. Aber die Anleitungen halten auch Tipps und Tricks für den erfahrenen User bereit, um tatsächlich alles 
aus Ozone rauszuholen.

Um das Dithering zu verstehen und es anzuwenden, ist die Lektüre der Dithering Guide unverzichtbar. In ihr 
finden Sie Lösungen zu gängigen Schwierigkeiten und sie ist ein Leitfaden, anhand dessen Sie schließlich die 
höchste Qualität für Ihr Produkt erzielen können.

Die Mastering- und Dithering Guides finden Sie auf der Ozone 3-CD 

Support
M-AUDIO Deutschland 
Kuhallmand 34
D-74613 Ohringen
Deutschland

Vertrieb: 49 7941 98 7000
E-Mail (Vertrieb): info@m-audio.de
Technische Assistenz: 49 7941 98 70030
E-Mail (Technische Assistenz): support@m-audio.de
Fax: 07941 98 70070
Homepage: http://www.m-audio.de
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Español

BIENVENIDO
Felicidades por la compra de iZotope Ozone 3. Ozone incluye algunos de los algoritmos 
DSP de masterización más potentes disponibles hoy en día. Gracias a sus intuitivas 
prestaciones de medición y productividad, como la gestión de presets y de historial, Ozone 
le proporciona todas las herramientas necesarias para la creación eficiente de masters de 
calidad profesional.
Esta guía le ayudará a familiarizarse rápidamente con Ozone. Para más información sobre las 
características de Ozone y para conocer algunos trucos de masterización, consulte la sección 
“Ayuda adicional” al final de esta guía.

INSTALACIÓN

Mac OS X
1. Introduzca el disco iZotope Ozone 3 en la unidad de CD-ROM de su computadora.
2.  Para explorar el contenido del CD, haga doble clic sobre el icono del disco iZotope Ozone 3 que 

aparecerá en su escritorio.
3. Para iniciar el programa de configuración, haga doble clic sobre el icono Install iZotope Ozone 3.
4.   Siga los pasos del programa de configuración.

Windows
1. Introduzca el disco iZotope Ozone 3 en la unidad de CD-ROM de su computadora.
2.  Si la página web de instalación de Ozone 3 no aparece automáticamente, haga doble clic sobre el 

icono de la unidad de CD-ROM en el Explorador de Windows, y a continuación haga doble clic sobre el 
archivo “index.html” o “index”.

3. Pulse el link “Install Ozone” para iniciar el programa de configuración de Ozone.
4.  Si el programa le pide que elija entre las opciones de abrir (“Open”) o guardar (“Save”) el archivo, 

seleccione “Open”.
5. Siga los pasos del programa de configuración.

EJECUCIÓN
Ozone es un plug-in, lo cual significa que debe abrirlo desde dentro de una aplicación 
de audio que normalmente recibe el nombre de “aplicación huésped”. A continuación le 
explicamos cómo puede ejecutar Ozone en las aplicaciones huésped más habituales. Los 
métodos utilizados por otras aplicaciones para cargar un plug-in son similares. Consulte la 
documentación de su aplicación huésped para instrucciones más específicas.

Pro Tools LE
1. Abra la vista “Edit”.
2. En la vista “Edit”, muestre la vista “Inserts”.
3. En los “Inserts” de una pista, pulse sobre una de las ranuras de plug-in vacías.
4. Seleccione “multi-channel plug-in” (plug-in multicanal) y a continuación “iZotope Ozone 3 (stereo)”.

Pro Tools TDM
1. Abra la vista “Edit”.
2. En la vista “Edit”, muestre la vista “Inserts”.
3. En los “Inserts” de una pista, pulse sobre una de las ranuras de plug-in vacías.
4. Seleccione “TDM”, “multi-channel plug-in” (plug-in multicanal) y por último “iZotope Ozone 3 (stereo)”.

Live
1. En el menú “View”, seleccione “Plug-In Effects”.
2. En la lista de “Plug-Ins”, haga doble clic sobre “iZotope Ozone 3”.
3.  Para visualizar la interfaz de Ozone, pulse el icono de la llave inglesa situado en la esquina superior 

izquierda.
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MOTU Digital Performer
1. Abra la “Mixing Board” (Consola de mezcla).
2. Haga clic sobre una ranura de inserción vacía en la parte superior de una pista y mantenga pulsado el 
botón del ratón. 
3. Seleccione “iZotope Ozone 3”. 

Logic
1. En la ventana “Arrange”, pulse sobre una pista audio para seleccionarla.
2.  En la parte izquierda de la ventana, haga clic sobre una ranura de inserción vacía y mantenga pulsado 

el botón del ratón.
3.  Seleccione la carpeta mono o estéreo en el menú desplegable y a continuación elija “iZotope Ozone 3”

Sonar
1. En una pista audio, haga clic con el botón derecho del ratón sobre la sección “FX”.
2. Seleccione “Audio Effects”, “iZotope” y “Ozone 3”.

Acid
1.  Pulse el botón “Track FX” (Efectos de pista), situado junto a los controles de volumen y silenciado de cada 

pista. La ventana “AUDIO PLUG-IN” debería mostrar la cadena de audio de la pista seleccionada.
2.  Si el “PLUGIN-CHOOSER” (Selector de plug-in) no aparece en pantalla, pulse el botón “Edit Chain” (Editar 

cadena).
3. Seleccione “Ozone 3” en la categoría “Third Party”. A continuación, elija “iZotope” y pulse “OK”.

Cubase SX
1. Abra la lista “Inserts” de una pista audio.
2. Seleccione una de las ranuras libres.
3. En el menú desplegable, seleccione “DirectX” y a continuación “iZotope Ozone 3”.

Audition
1. Cargue un archivo de audio en la vista “Edit”.
2. Defina la sección de audio que desea procesar.
3. Seleccione Ozone en “Effects” -> “VST” -> “iZotope” -> “Ozone 3...”.

Otras aplicaciones
Por favor, consulte la documentación de su aplicación huésped o póngase en contacto con 
el servicio de asistencia técnica.

ACTIVACIÓN
Ozone funcionará sin ninguna limitación durante 7 días. Transcurrido este periodo, la salida 
del plug-in se silenciará hasta que lo autorice. Cuando esté listo para autorizar el programa, 
tenga preparado su número de serie y:
Ejecute el plug-in y pulse el botón “Authorize” (Autorizar).

Pregunta/Respuesta
< Autorización por Internet
1. Pulse el link del “Paso 1”.
2.  En la página web, introduzca su número de serie, nombre de usuario y contraseña, o siga las 

instrucciones para registrarse y crear una nueva cuenta.
3. Copie la Respuesta resultante.
4. Pegue la Respuesta en la caja del “Paso 2” y pulse “Next” (Siguiente) para completar la autorización.
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< Autorización manual
1. Escriba la pregunta del “Paso 1” en la computadora que desee autorizar.
2.  En una computadora que disponga de acceso a Internet, visite la página http://www.izotope.com/

activate.html.
3.  Introduzca su número de serie, nombre de usuario y contraseña, o siga las instrucciones para registrarse 

y crear una nueva cuenta.
4.  Seleccione el producto que desee autorizar. Para ello, pulse sobre “authorize with challenge/response” 

(autorizar con pregunta/respuesta).
5.  Introduzca la Pregunta que ha anotado y pulse “Submit” (Enviar).
6.  Pegue la Respuesta resultante en la caja del “Paso 2” y pulse “Next” (Siguiente) para completar la 

autorización.

iLokTM Smart Key
El iLok sólo está disponible para los formatos de plug-in Pro Tools.

1. Por favor, visite http://www.izotope.com/activate.html.
2.  Introduzca su número de serie, nombre de usuario y contraseña, o siga las instrucciones para registrarse 

y crear una nueva cuenta.
3.  Seleccione el producto que desee autorizar. Para ello, pulse sobre “authorize with iLok” (autorizar con 

iLok).
4. Introduzca su ID de usuario de iLok (visite www.ilok.com para crear una ID gratuitamente).
5. Entre en su cuenta en www.ilok.com y transfiera la licencia a su iLok Smart Key.
6.  Inserte el iLok en un puerto USB de la computadora en la que desee utilizar el plug-in: la autorización 

quedará completada automáticamente.

PRIMEROS PASOS

Presets
Los Presets son un buen recurso para empezar a familiarizarse con los módulos. Para 
escuchar los presets, ejecute Ozone mientras reproduce una señal de audio en la aplicación 
huésped. Pulse el botón “PRESETS” y vaya seleccionando diversos presets para escuchar las 
diferencias del sonido. Pulse “OK” para elegir un preset y acceder a sus parámetros.

AYUDA ADICIONAL

Ayuda
Pulse el botón ‘?’ situado en la parte inferior derecha de cada ventana para abrir una caja de 
ayuda contextual. Estos documentos de ayuda describen todas las prestaciones y funciones 
del plug-in, y ofrecen algunos consejos y atajos de teclado. 
Guías de masterización y dithering
La Ozone Mastering Guide (Guía de Masterización) es una excelente introducción al proceso 
de masterización para los usuarios no iniciados. Esta guía también es útil para el usuario 
profesional, ya que proporciona algunos trucos y consejos que le ayudarán a sacar el máximo 
partido a Ozone.
La Dithering Guide (Guía de Dithering) es una lectura obligada para la correcta comprensión 
y aplicación del proceso de dithering. Trata los problemas más comunes que pueden surgir 
durante este proceso, y resulta crucial para conseguir la máxima calidad posible en su 
producto final.
Las guías de Masterización y Dithering están incluidas en el disco de Ozone 3 
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Asistencia técnica - En el caso de que surja algún problema con el iZotope Ozone 3, no dude en 
consultar el manual de usuario para más información.

También le recomendamos visitar nuestra página web en www.m-audio.com, para comprobar si existen 
actualizaciones de los controladores y recibir asistencia técnica. Desde ahí puede rellenar el formulario de 
asistencia técnica y hacernos llegar sus preguntas o dudas.

Alternativamente, puede enviarnos un mensaje de correo electrónico a la dirección support@m-audio.com, 
también puede contactar con nosotros por teléfono llamando al (626) 633-9055.

El servicio técnico telefónico está disponible de 7am - 7pm PST.
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BENVENUTI
Ci congratuliamo con voi per l’acquisto di iZotope Ozone 3. Ozone offre alcuni tra i più potenti algoritmi DSP 
dedicati al mastering oggi sul mercato. Grazie a meters di facile lettura e funzioni appositamente pensate per 
velocizzare il lavoro (come preset richiamabili e gestione cronologica di ogni singola operazione effettuata), 
Ozone mette a disposizione dell’utente tutti gli strumenti necessari per creare masters professionali nel modo 
più efficiente possibile.

Questa guida vi sarà d’aiuto per cominciare ad utilizzare Ozone sin da subito, in maniera semplice e rapida. 
Per approfondire le caratteristiche di Ozone, nonché per alcuni suggerimenti relativi al mastering, consultate 
il capitolo “Ulteriore Aiuto” alla fine di questa guida.

INSTALLAZIONE

Mac OS X
1. Introdurre il disco iZotope Ozone 3 nell’unità CD-ROM.
2.   Fare un doppio clic sull’icona iZotope Ozone 3 presente sul desktop per visualizzare il contenuto del 

CD.
3. Per avviare il programma di setup, fare un doppio clic sull’icona Install iZotope Ozone 3.
4. Seguire i passi indicati dal programma di setup.

Windows
1. Introdurre il disco iZotope Ozone 3 nell’unità CD-ROM.
2.  Se la pagina web Install Ozone 3 non appare automaticamente fare un doppio clic sull’icona del drive 

CD ROM in Windows Explorer e, successivamente, un doppio clic sul file “index.html” o “index”.
3. Cliccare sul link “Install Ozone” per dare inizio al setup di Ozone.
4. Se appare la richiesta di “Aprire” o “Salvare” il file, scegliere “Aprire”.
5. Seguire i passi indicati dal programma di setup.

AVVIO
Ozone è un plug-in e quindi deve essere attivato all’interno di un’applicazione audio compatibile, generalmente 
definita come “applicazione host”. Qui sotto troverete alcune indicazioni su come attivare Ozone all’interno 
delle più comuni applicazioni host. La maggior parte delle applicazioni utilizzano metodi simili per caricare 
al loro interno un plug-in. Si consiglia di consultare la documentazione relativa all’applicazione host utilizzata 
per ottenere istruzioni più specifiche.

Pro Tools LE
1. Passate a “Edit View”.
2. Visualizzate “Inserts View”, all’interno di “Edit View”.
3. Nello spazio “Inserts” di una traccia, fate clic su uno degli slot vuoti per plug-ins.
4. Selezionate “multi-channel plug-in” e “iZotope Ozone 3 (stereo)”.

Pro Tools TDM
1. Passate a “Edit View”.
2. Visualizzate “Inserts View”, all’interno di “Edit View”.
3. Nello spazio “Inserts” di una traccia, fate clic su uno degli slot vuoti per plug-ins.
4. Selezionate “TDM”, “multi-channel plug-in” e “iZotope Ozone 3 (stereo)”.

Live
1. All’interno del menù “View” selezionare “Plug-In Effects”.
2. Dalla lista che appare sotto “Plug-Ins” fare doppio clic su “iZotope Ozone 3”.
3.  Per accedere all’interfaccia grafica di Ozone fare click sul simbolo della chiave inglese situato nell’angolo 

in alto a sinistra.

MOTU Digital Performer
1. Accedere alla finestra “Mixing Board”.
2.   Cliccare e tener premuto il pulsante del mouse su uno degli slot insert vuoti situati nella parte superiore 

della traccia audio.
3. Selezionare “iZotope Ozone 3”.

Italiano
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Logic
1. All’interno della “Arrange Window” fare clic su una traccia audio per selezionarla.
2. Sulla sinistra della finestra, cliccare e tener premuto il pulsante del mouse su un insert vuoto.
3.   Accedere alla cartella mono o a quella stereo all’interno del menù corrispondente e successivamente 

selezionare “iZotope Ozone 3”

Sonar
1. Su una traccia audio fare clic col pulsante destro del mouse sulla sezione “FX”.
2. Selezionare “Audio Effects”, “iZotope” e “Ozone 3”.

Acid
1.  Cliccare sul pulsante “Track FX” situato accanto ai controlli di volume e mute di ciascuna traccia 

audio. La finestra “AUDIO PLUG-IN” dovrebbe apparire, mostrando il flusso audio relativo alla traccia 
selezionata.

2. Se l’opzione “PLUGIN-CHOOSER” non è visibile fare clic sul pulsante “Edit Chain”.
3.  Selezionare “Ozone 3” all’interno dei menù “Third Party” e “iZotope”, e successivamente cliccare su 

“OK”.

Cubase SX
1. Espandere la lista “Inserts” di una traccia audio.
2. Selezionare uno degli slot liberi.
3. Dal menù a comparsa selezionare “DirectX” e successivamente “iZotope Ozone 3”.

Audition
1. Caricare un file audio in “Edit View”.
2. Selezionare la parte di audio che dovrà essere processata.
3. Selezionare Ozone all’interno di “Effects” -> “VST” -> “iZotope” -> “Ozone 3...”.

Altri Software
Si consiglia di consultare la documentazione relativa all’applicazione host utilizzata o contattare il servizio di 
supporto tecnico.

ATTIVAZIONE
Ozone continuerà a funzionare senza nessuna limitazione per 7 giorni. Alla fine di questo periodo di prova 
l’output audio si interromperà periodicamente, fino a quando il plug-in non verrà completamente autorizzato. 
Quando intendete procedere con l’autorizzazione tenete a portata di mano il vostro numero di serie e:

< Avviate il plug-in e cliccate sul pulsante “Authorize”.

Sistema “Challenge/Response”
< Autorizzazione via Internet
1. Cliccare sul link nella finestra “Passaggio 1”.
2.  Una volta sul sito web immettere il vostro numero di serie, nome utente e password, o seguire le 

istruzioni per la registrazione e la creazione di un nuovo account.
3. Copiare il codice Response.
4.  Incollare il codice Response all’interno della finestra mostrata in “Passaggio 2” e cliccare “Avanti” per 

completare l’autorizzazione.

< Autorizzazione manuale
1. Sul computer che si intende autorizzare annotare il codice Challenge mostrato in “Passaggio 1”.
2. Dal computer con accesso internet raggiungere l’indirizzo http://www.izotope.com/activate.html.
3.  Immettere il vostro numero di serie, nome utente e password, o seguire le istruzioni per la registrazione 

e la creazione di un nuovo account.
4. Selezionare il prodotto da autorizzare cliccando su “autorizzare con challenge/response”.
5. Immettere il codice Challenge annotato precedentemente e cliccare su “Inoltra”.
6.  Imettere il codice Response risultante nella finestra “Passaggio 2” e cliccare su “Avanti” per completare 

l’autorizzazione.
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iLokTM Smart Key
Il sistema iLok è solo disponibile per plug-is in formato Pro Tools.

1. Si prega di visitare http://www.izotope.com/activate.html.
2.  Immettere il vostro numero di serie, nome utente e password, o seguire le istruzioni per la registrazione 

e la creazione di un nuovo account.
3. Selezionare il prodotto da autorizzare cliccando su “autorizzare con iLok”.
4. Immettere il vostro iLok User ID (visitare www.ilok.com per crearne uno gratuitamente).
5. Effettuate il Login al vostro account a www.ilok.com e trasferite la licenza alla iLok Smart Key.
6.  Collegando iLok ad una porta USB libera del computer su cui intendete utilizzare il plug-in sarete 

automaticamente autorizzati.

GUIDA INTRODUTTIVA

Preset
I Preset rappresentano un ottimo modo per cominciare a conoscere i vari moduli. Per ascoltare un preset 
lanciare Ozone mentre l’applicazione host sta riproducendo materiale audio. Selezionare il pulsante “PRESETS” 
e cliccare su ciascun preset per ascoltare come il plug-in influisce sul suono in riproduzione. Cliccare su “OK” 
per selezionare il preset interessato e regolarne i parametri.

ULTERIORE AIUTO

Guida di Aiuto
Fare clic sul pulsante ‘?’ situato in basso a destra di ciascuna finestra per visualizzare la guida di aiuto 
contestuale. Questi documenti guida descrivono tutte le funzioni del programma, offrono semplici 
suggerimenti e indicano le varie combinazioni da tastiera.

Guide al Mastering e al Dithering
A chi inizia, la guida Mastering con Ozone può offrire un eccellente panoramica sui vari aspetti relativi al 
mastering audio. Anche l’utente professionale troverà in questa guida numerosi suggerimenti e tecniche che 
lo aiuteranno a sfruttare al massimo le potenzialità operative di Ozone.

La guida al Dithering è una lettura obbligata per capire i principi e la corretta applicazione delle tecniche 
di dithering. Oltre a mettere in luce gli errori più comuni, rappresenta una risorsa cruciale per ottenere la 
massima qualità possibile dal vostro prodotto finale.

Le guide al Mastering e al Dithering sono incluse all’interno del disco di Ozone 3.

Assistenza
Se si sperimentano difficoltà con l’iZotope Ozone 3, accertarsi di controllare prima il manuale dell’utente per 
informazioni aggiuntive.

 Si consiglia inoltre di consultare il sito all’indirizzo www.m-audio.com, per assistenza tecnica. All’interno del 
sito è possibile compilare il modulo di richiesta di assistenza tecnica se si hanno domande o dubbi da 
sottoporre.

In alternativa è possibile inviare un’email all’indirizzo support@m-audio.com.
Oppure, contattare M-Audio per telefono al numero: +00-1-(626) 633-9055
L’assistenza tecnica telefonica è disponibile dalle 7:00 alle 19:00 PST
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はじめに
iZotope Ozone 3をお買い上げ頂きまして誠に有難うございます。Ozoneは最もパワフルな64-Bit DSPアルゴリズムを
搭載したマスタリング・プラグインです。プリセットやヒストリーマネージメントのように直感的な高機能を初めと
して、Ozoneにはプロフェッショナルなマスターを効果的にクリエイトするツールが全て装備されいます。

クイックスタートガイドではOzoneの基本的な使い方を説明します。Ozoneの機能やマスタリングに関しての詳しい
情報は、このガイドの最後にある「詳しい使い方」の項をご参照下さい。

インストール
Mac OS X
1. iZotope Ozone 3のドライバCD-ROMをコンピュータのCD-ROMドライブに挿入します。
2. iZotope Ozone 3アイコンをダブルクリックしてCDの内容を確認します。
3. Install iZotope Ozone 3アイコンをダブルクリックしてセットアッププログラムを起動します。
4. セットアッププログラムの手順に従ってセットアップを完了して下さい。

Windows
1. iZotope Ozone 3のドライバCD-ROMをコンピュータのCD-ROMドライブに挿入します。
2.  Install Ozone 3のウェブページが表示されない場合は、エクスプローラーからCD-ROMのアイコンをダブルク

リックし、index.htmlまたはindexファイルをダブルクリックします。
3. Install OzoneのリンクをクリックするとOzoneのセットアップが起動します。
4. 「開く」または「保存する」が表示されますので「開く」を選択します。
5. セットアッププログラムの手順に従ってセットアップを完了して下さい。

OZONEの起動
Ozoneはプラグインですので、オーディオアプリケーションまたはホストアプリケーションのプログラム内で起動す
る必要があります。一般的なホストアプリケーションでOzoneを開く方法を以下にご説明します。プラグインをロー
ドする方法は他のアプリケーションでも大きな違いはありません。詳しくはホストアプリケーションの取扱説明書を
ご参照下さい。

Pro Tools LE
1. 「Edit（編集）」ビューに切替えます。
2. 「Edit」ビューから「Insert（挿入）」ビューを表示します。
3.  トラックの「insert（挿入）」の下にあるプラグインスロットから使用していない物を一つ選んでクリックします。
4. multi-channel plug-in（マルチチャンネルプラグイン）>iZotope Ozone 3（stereo）を選択します。

Pro Tools TDM
1. 「Edit（編集）」ビューに切替えます。
2. 「Edit（編集）」ビューから「Insert（挿入）」ビューを表示します。
3.  トラックの「Insert（挿入）」の下にあるプラグインスロットから使用していない物を一つ選んでクリックします。
4.  TDM>multi-channel plug-in（マルチチャンネルプラグイン）>iZotope Ozone 3（stereo）を選択します。

Live
1. 「View（ビュー）」メニューからPlug-In Effects（プラグインエフェクト）を選択します。
2. Plug-Ins（プラグイン）の下にあるリストからiZotope Ozone 3をダブルクリックします。
3. 左上の角にあるレンチのアイコンをクリックするとOzoneのインターフェイスが表示されます。

MOTU Digital Performer
1. 「Mixing Board（ミキシング・ボード）」を開きます。
2. トラック最上部にある使用可能なインサートをクリック&ホールドします。
3. iZotope Ozone 3を選択します。

Logic
1. 「Arrange（アレンジ）」ウィンドウでトラックをクリックして選択します。
2. ウィンドウの左にある、使用可能なトラックをクリック&ホールドします。
3. メニューからモノラルまたはステレオのフォルダを選択し、続いてiZotope Ozone 3を選択します。

日本語
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Sonar
1. オーディオトラックの「FX」セクションを右クリックします。
2. Audio Effects（オーディオ・エフェクト）-> iZotope -> Ozone 3の順に選択します。

Acid
1.  各トラックのボリュームとミュートコントロールの横にある「Track FX」ボタンをクリックします。「AUDIO PLUG-

IN（オーディオ・プラグイン）」ウィンドウに選択したトラックのオーディオチェーンが表示されます。
2.  「PLUGIN-CHOOSER（プラグイン・チューザー）」が表示されない場合、「Edit Chain」のボタンをクリッ

クします。
3. 「Third Party」のiZotopeからOzone 3を選択し「OK」をクリックします。

Cubase SX
1. オーディオトラックの「Inserts（挿入）」からインサートリストを開きます。
2. 使用可能なスロットを選択します。
3. ポップアップメニューから「DirectX」を選択し、続いて「iZotope Ozone 3」を選択します。

Audition
1. 「Edit（編集）」ビューでオーディオファイルを開きます。
2. オーディオのプロセスする部分を選択します。
3. Effects（エフェクト）-> VST -> iZotope -> Ozone 3の順に選択します。

その他
ホストアプリケーションの取扱説明書をご参照になるか、テクニカルサポートまでご連絡下さい。

アクティベーション
Ozoneは7日間フルバージョンのままで動作しますが、7日を過ぎると認証手続きをするまでオーディオ出力が定期的
に停止します。シリアル番号をご用意になり、以下の手順で認証を行って下さい。

< 「認証」ボタンをクリックしてプラグインを起動します。

チャレンジ/レスポンス
<  インターネットでの認証
1. 「Step 1」のリンクをクリックします。
2.  ウェブサイトでシリアル番号、ユーザー名、パスワードを入力してアカウントにログインするか、登録手続き

を済ませて新しいアカウントを作成します。
3. レスポンスをコピーします。
4. レスポンスをStep 2のボックスにペーストして、「次へ」をクリックして認証を完了します。
<  手動で認証
1. 認証を行うコンピュータで、Step 1にチャレンジを入力します。
2.  インターネットに接続しているコンピュータからhttp://www.izotope.com/activate.htmlをアクセスしま

す。
3.  シリアル番号、ユーザー名、パスワードを入力してログインするか、登録手続きを済ませて新しいアカウント

を作成します。
4. 「チャレンジ/レスポンスを使って認証」をクリックします。
5. チャレンジを入力して「送信」をクリックします。
6. レスポンスをStep 2のボックスに入力し、「次へ」をクリックして認証を完了します。

iLok™ スマートキー
iLokはPro Toolsのプラグイン・フォーマットにのみ有効です。

1. http://www.izotope.com/activate.htmlにアクセスします。
2.  シリアル番号、ユーザー名、パスワードを入力してアカウントにログインするか、登録手続きを済ませて新し

いアカウントを作成します。
3. 「iLokによる認証」をクリックして認証をする製品名を選択します。
4.  iLokユーザーIDを入力します。（iLokのアカウントはwww.ilok.comのウェブサイトで無料で作成できます。）
5. www.ilok.comでiLokのアカウントにログインし、情報をiLokスマートキーに転送します。
6. プラグインを使うコンピュータのUSB端子にiLokを差し込むと、自動的に認証が行われます。
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基本操作
プリセット
プリセットはモジュールを確認する簡単な方法です。プリセットの内容を確認するには、ホストアプリケーションで
オーディオを再生中にOzoneを起動します。PRESETボタンをクリックします。各プリセットをクリックすると音が   
違って聞えます。OKをクリックするとプリセットが選択されパラメーターを変更できます。

詳しい使い方
ヘルプ
各ウィンドウの右下にある「?」マークをクリックすると操作状況に合ったヘルプが表示されます。ヘルプには操作方
法、簡単なヒント、ショートカットキーなどについての説明が含まれます。

マスタリング・ガイドとディザリング・ガイド
Ozoneマスタリング・ガイドには初心者の方にもわかりやすくマスタリングの方法が説明されています。Ozoneのマ
スタリング機能を使いこなすためのヒントやコツが記載されていますのでマスタリングに精通したプロの方も、是非
ご活用下さい。

ディザリング・ガイドではディザリングについての理解を深めるのに役立つリソースが説明されています。よくある
落し穴についての対処方法が含まれ、最終的に高いクオリティに達成するには不可欠なガイドです。

マスタリング・ガイドとディザリング・ガイドはOzone 3のCD-ROMに入っています。

サポート
E-mailの場合：

< win-support@m-audio.co.jp（Windows）
< mac-support@m-audio.co.jp（Macintosh）

株式会社エムオーディオジャパン

〒460-0002

愛知県名古屋市中区丸の内2-18-10
電話番号：（052）218-0859
Fax：（052）218-0875
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